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Editorial 
Hello and welcome to the February 

issue of 2Dartist. I hope that 2011 

has been an artistic year for you 

so far. Also a very happy Chinese 

New Year to our Chinese readers, 

I hope you have a great year of the 

Rabbit.

This month’s issue is massive, it’s 

epic. You could maybe even say 

it was GIANT! Forgive my abstract link to our tutorials this month, but 

we continue our Photo Real fantasy series by tackling a photo real giant 

with Richard Tilbury. Rich talks a lot about the design and idea behind 

his image and by giving it a story makes it appear a lot more believable 

and realistic. Rich is a pro when it comes to integrating photo’s to a 

digital painting, and gives us master class as to how to do this and make 

it look real. Rich has a double bill in this month’s issue and also handles 

our portrait tutorial. In this issue Rich shows us how to paint a boy and 

his subject matter is his son Gabriel.

Another outstanding tutorial this month is by Jesse van Dijk. We have 

been asking seasoned industry professionals to guide us through the 

core subjects that any artist needs to appreciate, and this month Jesse 

shows us ways to portray and use light and color to accentuate the 

message in our image, and really drive home its entire concept. Jesse 

shows us how to do this by using examples from his portfolio which is 

fantastic. A big thanks goes to Jesse for shedding light on the matter 

(sorry I couldn’t resist).

This month’s issue contains the final chapter of our Creatures from 

Folklore series. We will be sad to see the series come to an end as the 

tutorials have been great, but we do wrap things off in the best way 

possible with another fantastic tutorial. Jason Wei Che Juan doesn’t 

only show us how he painted his image but gives us an insight into 

Chinese folklore. When he told me he wanted to paint a Huli Jing, I 

thought to myself “a what!” but after a brief lesson in Chinese culture 

and folklore I knew what he meant, and you will as well once you have 

read his practical and educational tutorial.

I managed to catch up with Serge Birault for this month’s issue. For 

those of you who are regular readers of 2Dartist you will know who I 

mean as he is a regular in our galleries. Serge is Pin-up royalty and 

has blown us away for years with his realistic paintings and fantastic 

character portrayals. If you are impressed by Serge’s images watch this 

space as soon he will be doing a Pin-up series for our magazine.

Fantasy plays a huge part in digital art. It influences thousands of 

artists from around the world and has become a large part of the film 

and gaming industry. So much of what we see within this genre is 

drawn from fairy tales and folklore. In this tutorial series our artists will 

be showing us how to research creatures from folklore and use this 

gathered information to create an original and accurate depiction of 

these fantasy characters.

Chapter 1: September Issue 57 | Goblin | Andrei Pervukhin 
Chapter 2: October Issue 58 | Fairy | Nykolai Aleksander 
Chapter 3: November Issue 59 | Siren | Min Yum 
Chapter 4: December Issue 60 | Ogre | Richard Tilbury 
Chapter 5: January Issue 61 | Troll | Simon Dominic 
Chapter 6: This Issue | Huli Jing | Jason Wei Che Juan

This month’s interview is with pin-up royalty Serge Birault. 

Serge has a unique style that is instantly recognizable and 

breathtakingly realistic, and in the following pages he gives 

us a little insight into how he paints, as well as telling us 

about how he has to balance out his super-realistic paintings 

with some cool speed paintings.

“The 
soft round 
airbrush is 
my favorite 
tool. When you 
use it with a very 
low opacity you can 
easily blend colors and 
do clean gradients. It’s a bit 
like a traditional airbrush, 
but easier.”

“After playing with the layer 
modes you can get very nice 
results from which you can 
start to paint.”

This month we feature:

Rafael Nascimento

Andreas Rocha

Amenov Vitaliy

Tiago da Silva

Paul Abrams

Sasha Gorec

JP Räsänen

Claire Beard

Steve Jung

Songnan Li 

!

Artist: 

Andrew Jones
website: www.shareoneplanet.org

Some 

things in 

art cannot 

be avoided, 

and some things 

must be understood to 

create great images. We 

call these Art Fundamentals. 

The same compositional rules 

and techniques to demonstrate depth 

of field are being used today as were being 

used hundreds of years ago. In this series industry 

professionals will be teaching us the art fundamentals that 

they put into practice, and will be sharing amazing tips that we can 

all use to improve the quality of our work.

Chapter 01 |  January Issue 061
Composition

Chapter 02 |  This Issue
Lighting and Color

Chapter 03 |  Next Issue
Portraying Emotion

Chapter 04 |  April Issue 064
Story Telling

Chapter 05 |  May Issue 065
Perspective and Depth

Intro Text

“I find it far easier to 
see where something 

may be wrong if all of 
the components are in 

place. If you were to 
paint a perfect mouth 

and nose they may 
still look wrong 
if the eyes were 

missing.”

Chapter 04 | Male  | Richard Tilbury

Portraits are one of the most commonly tackled subjects in all forms of art, but also one of the most common that we see 
go horribly wrong. In this series our talented artists will be showing us how to use a photo reference to paint an accurate 
portrait without being tempted to do a paintover. We don’t stop there though; we also venture into the specialized field 

of caricatures. Caricatures are a tricky subject to deal with, but there are ways that you can use your photo reference to 
make them easier and this series gives us an insight into this process.

Yuehui Tang is a fantastic artist and has a great way of painting portraits. In this Making Of he 

shows us how he painted his image “Portrait” by starting with a black page, adding the light and soft 

tones to create a grayscale image, and then painting over it.

“It is important to get 
the correct levels of 
dark in the shadow 
and show how the 

skin reflects the 
light.”

The fantasy genre is hugely popular in the CG industry and has been showcased in hundreds of 

movies, computer games and artworks over the years. With such potential for magic, monsters 

and imaginations to run wild, it’s easy to see why fantasy is such an attractive subject. But giving 

fantastical ideas enough of a basis in reality to be convincing can be difficult. In this series our 

talented artists are going to take one aspect of fantasy – legendary creatures – and show us 

how they would tackle this problem. Some use photo integration, others paint the creatures very 

carefully with a steady hand, but all share the benefits of their experience and reveal the tricks and 

techniques they use to make the unreal seem real.

Chapter 1 |  January Issue 061
Griffin

Chapter 2 |  This Issue
Giant

Chapter 3 |  Next Issue
Dragon 

Chapter 4 |  April Issue 064
Yeti

Chapter 5 |  May Issue 065
Loch Ness Monster

Chapter 6 |  June Issue 066
Alien

With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some 

exclusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-colour, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Baba Yaga” 
by Min Yum
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I am swiftly running out of space so I will speed up and just let you know 

about the cool technique used by Yuehui Tang in this month’s Making 

Of. He uses gray scale but backwards, sound weird? Check it out to see 

what I mean. This month’s issue also contains a sketchbook by Dimitar 

Tzvetanov and gallery images by Steve Jung, Andreas Rocha, Claire 

Beard and many more. Anyway, don’t take my word for it, read on and 

check it out!

Copyright © 1999-2011 3DTotal.com Ltd. All Rights reserved
All products and websites created/published by 3DTotal.com Ltd including www.3dtotal.com, 

www.3dcreativemag.com, www.2dartistmag.com all physical books, ebooks, emags, video content, 

texture libraries and any future releases may not be reproduced in any form or by any means, 

without the prior written consent of the publisher.



Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display; 

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!
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Jesse 
van Dijk

Concept Artist and Production 

Designer from Amsterdam, the 

Netherlands, with over four 

years of industry experience. 

Immediately after receiving his Master’s degree 

in Industrial Design at the Delft University of 

Technology, he went to work in the games industry. 

He is currently a senior concept artist at W! Games, 

Amsterdam, and does freelance work as well.

 

http://www.jessevandijk.net/

jesse@jessevandijk.net

Dimitar 
Tzvetanov
Dimitar Tzvetanov sees Cg as 

hobby and work. Dimitar works 

in the video games industry and 

has been doing so for more 

than 10 years. Currently Dimitar works in Haemimont 

Games in Bulgaria as a lead 3d/Environment artist 

and has several images in Ballistic publishing books 

and some magazines too. 

 

http://www.artbychrom.com/

chrom@artbychrom.com

Richard 
Tilbury 
Has had a passion for drawing 

since being a couple of feet 

tall. He studied fine art and was 

eventually led into the realm 

of computers several years ago. His brushes have 

slowly been dissolving in white spirit since the late 

90s, and now his graphics tablet has become their 

successor. He still sketches regularly and balances 

his time between 2D & 3D – although drawing will 

always be closest to his heart. 

http://www.richardtilburyart.com

rich@3dtotal.com

ContributorsContributors

Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out a bit more about them! 

If you would like to be a part of 3DCreative or 2DArtist magazine, please 

contact: simon@3dtotal.com
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3DTotal is glad to announce that the successful anti-piracy system used on ConceptArt.Org to protect it’s video content is now being 

used to bring an end to piracy of the content produced by the incredible artists who support our magazines, website and tutorials 

which are enjoyed by so many.  This anti-piracy effort has brought to light many of the users who have been pirating content illegally 

in the ConceptArt.org community and it is now assisting with protecting and enforcing copyrights here.

3DTotal greatly appreciates all our customers and the incredible artists who support this community with products.  Piracy has 

become a major obstacle that must be resolved in order to see the artists who create these works and 3DTotal see success long into 

the future.  Without the content sold here, this community and resource would not be what it is.  With the support of our customers we 

have been able to offer an ever increasing stable of great content at affordable prices.  Thank you all for your continued support.   We 

are here to help teach and assist artists worldwide.  

3DTotal would like to thank everyone who has purchased the magazine, our anti-piracy efforts are already working and last month we received 

the most sales to date. With this continued push and support from the community we can make the mag even better. We plan to re-invest the 

profits back into the magazine and have already started discussions with elite artists to provide you with even more improved content. We’re also 

considering many new wonderful ideas which we will start to reveal over the coming months. 

Thanks again for your support.

Yuehui
Tang
Yuehui Tang was born in the 

Heilongjiang Province in China 

and graduated from Harbin 

Teachers University in 1999. 

Yuehui has had numerous pieces of art displayed in 

varying books and has won many CG competitions.

 

http://www.cgtnt.com

tyhart@163.com

Jason
Wei Che Juan 

Is a Character Artist born in 

Taichung, Taiwan in 1977 

who has always wanted to be 

an artist.  After finishing a BA 

Degree in Maths in 2001, with his deeply embedded 

dream of being an artist, he decided to take his first 

drawing class at the Art Institute of Seattle.  In 2004 

he began his career, working on the Narnia DS 

game.  In 2005, he took things further by learning 

oil painting.  He currently works at Arena.Net as a 

Character Artist.

www.jasonjuan.com/ | Jasonj05@msn.com



This month’s interview is with pin-up royalty Serge Birault. 

Serge has a unique style that is instantly recognizable and 

breathtakingly realistic, and in the following pages he gives 

us a little insight into how he paints, as well as telling us 

about how he has to balance out his super-realistic paintings 

with some cool speed paintings.

“The 
soft round 
airbrush is 
my favorite 
tool. When you 
use it with a very 
low opacity you can 
easily blend colors and 
do clean gradients. It’s a bit 
like a traditional airbrush, 
but easier.”
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Serge Birault Interview

Interview with 
Serge Birault

Hi Serge! Now, many of our readers will be 

familiar with your work as you are a regular in 

our galleries, and pretty much known as the 

digital pin-up king! But can you tell us a little 

about how you got interested in art, and how did 

you end up painting pin-ups?

The digital pin-up king! Oh God, where is my 

crown? I’m not sure I deserve that title. There 

are so many great pin-up artists like Aly Fell, 

Matt Dixon, Loopydave, Andy Hickinbottom 

or Rebeca Puebla… I loved Jean Auguste 

Dominique Ingres and William Bouguereau 

when I was younger. Then I discovered Gil 

Elvgren and, of course, Hajime Sorayama and 

I knew what I wanted to do. I had never seen 

such realistic rendering before and I spent a lot 

of time trying to emulate his style. Sorayama’s 

pin-ups are naughtier than mine. I would say he 

is my major technical influence, but Elvgren’s 

girls are simply the best pin-ups of all time. Like 

him I try to do humorous pictures.

I also love caricatures. I’m not that good at 

them, but a lot of caricaturists like Sebastian 

Krüger or Dominic Philibert have had a great 

influence on me. I try to avoid proportions that 

are too realistic. Cartoon pin-ups by Loopydave, 

for example, have provided me with some new 

references.

Perhaps I should have said digital pin-up royalty 

- I love the rest of the royal family too! There are 

a lot of names I recognize in there from my days 

at art college. It sounds like you were heavily 

influenced by some great, traditional artists. Do 

you have a traditional art background? How did 

you end up painting digitally?

I didn’t study art, but I practiced using acrylic, 

oils and (of course) airbrushes. I began to use a 

computer a very long time ago, nearly 20 years 

in fact. It was very hard to create big digital files, 

but it was far easier than working traditionally. I 

ended up painting digitally because I’m lazy.

Those in the know will be aware that you are 

currently preparing a tutorial series for us that 

we are very excited about, but for those who 

can’t wait maybe you can give us a brief insight 

into some of your processes and the tools that 

you use. Don’t give too much away though; they 

will need to read the series for that!

I always use the same technique. The Soft 

Round airbrush is my favorite tool. When you 

use it with a very low opacity you can easily 

blend colors and do clean gradients. It’s like a 

traditional airbrush, but easier.

Most of us will be familiar with your very clean 

and tidy pin-ups, but whilst looking through your 

galleries I came across some really nice speed 

paintings. Do you do these for fun, or do you 

find it is a nice way to experiment with ideas 

without committing your time to a complete 

project?

Yes, I like doing speed paintings too. When I 

finish a big picture I need to do some fast and 

little sketches; it’s a good way to find new ideas 

or new techniques. I can easily create more 

dynamic pictures than classical pin-up poses. 
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Unfortunately my clients never ask for this 

kind of work; they always want clean and fully 

detailed pictures.

That is surprising. The variety in your portfolio 

is outstanding. Do you find it quite liberating 

to shake loose from your very clean rendering 

techniques from time to time?

Oh yes! Liberating is the word. I think I must 

look like a maniac when I do this kind of picture. 

I will have to try to mix these two styles, like 

Simon Bisley. He’s a very good example of what 

I want to try to do.

You mentioned that you tend to be asked to 

create pin-ups more than other sorts of images. 

If you could work in any part of the industry or 

on any project that didn’t involve pin-ups what 

would it be?

Actually, I’m currently working as character 

designer for a 3D animated series for very 

young children (between 3 and 5 years old). 

Strange, isn’t it? But, hell yeah - I like that!

I am sure I am not the only one who has looked 

at your work and thought “Wow - that must have 

taken ages!” How long, on average, does it take 

you to complete a painting? Do you find you 

spend your whole day in front of the computer?

An average picture takes me about two days, 

or about 15 hours. But I have already spent 

more than 70 hours on a picture for Sashimi’s 

Revenge because of the very complicated 

tones. If you want to have very clean render 

you have to be patient, it’s the only solution. 

It’s not a problem for me, I’m patient person… 

at least I am when I am painting. I’ve got two 

children so I can’t spend my whole day in front 

of my computer. I will soon have to paint with 

acrylics and I think that will be a good thing. I am 

beginning to have binary dreams with only zeros 

and ones in them.

Sitting in front of the computer all day can be 

a real drag. Do you think it’s important to get 

outside and see the sights, not only to keep you 

sane but to look for influences and inspiration?

I try to not work during weekends and spend 

time with my sons. Sometimes I realize they are 

probably the only reason why I see the light of 

“If you want to have very 
clean rendering you have 
to be patient, it’s the only 

solution.”
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the day. This job is like a vampire. Even when 

I go out to see my friends, I work… I look at 

faces, the lights, the reflection… It’s not a job 

but a kind of curse! 

I will travel a lot this year. I have a lot of master 

classes to do so I’m going to try and visit a lot 

of museums. In museums, I look like a child in 

a toy shop. 

You mention that you will soon be doing some 

work in acrylics. Is this a project that you can 

tell us about? When you work traditionally what 

tools and type of paints do you use? And do 

you ever try to reproduce the same kind of finish 

on your traditional images as you do on your 

detailed pin-ups?

I can’t speak about it right now, but it’s for an 

exhibition. I try to have the same finish and 

the same level of detail. I will work with acrylic 

because I can’t work on canvas. I no longer 

have an airbrush and it will be difficult with only 

brushes.

What is the CG industry like in France? Do you 

find that most of the projects that you do are for 

foreign clients, or is there a big demand for this 

kind of thing over there?

I have very few French clients. I had some 

very bad experiences with them. It’s a kind of 

tradition to pay artists badly and late and give 

short deadlines in France. I try to avoid them. 

There are, of course, some exceptions. One of 

my best clients is French and I sometimes teach 

in a very good and pleasant art school. So I 

really don’t know what the French CG industry 

looks like, and I don’t want to know.

Thanks for agreeing to be interviewed by us. 

It has been a lot of fun looking through your 

portfolio and finding out more about you. I am 

really looking forward to letting everyone see the 

amazing images you have made for the pin-up 

series. I know it will be a massive hit! Thanks 

Serge, speak to you soon.

My pleasure! Thank you too. Now I must go and 

finish all the pin-ups I have to do for you *whip 

crack*!

Serge Birault
For more information please visit:

http://www.sergebirault.fr/sb/index.php 

Or contact them at:

serge.birault@hotmail.fr
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Interview  Serge Birault
Article Courtesy : Simon Morse





“After playing with the layer 
modes you can get very nice 
results from which you can 
start to paint.”



page 15www.2dartistmag.com Issue 062 February 2011

Dimitar Tzvetanov Sketchbook

Sketchbook of 
Dimitar 
Tzvetanov
It is a little bit strange for me to talk about 

my sketchbook because I am actually a 3D 

artist, or I started my career as a 3D modeler 

anyway. But years passed and I found that 

the 2D part of game creation work is very 

interesting too. Some of the sketches here 

are for practice, some are for personal 

projects and some for commercial work. Not 

all are new; some of them I made several 

years back.

I will start with the oldest first. These two 

plants and the fish-like building were made 

for an unreleased game project. The setting 

was an alien desert world with giant plants 

and the remains of an ancient culture 

from before the planet was turned into a 

waste land. I drew them on paper first and 

then colored them in Photoshop (Fig.01 – 

Fig.03d).
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Sketchbook  Dimitar Tzvetanov
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Dimitar Tzvetanov Sketchbook

Those two are also for a game project. They 

were created to establish the mood of the 

game levels. This one was a post-apocalyptic 

setting for a hack and slash game 

(Fig.04 – Fig.05). 

These three here are new works from the past 

few months made for a personal project that I 

am working on. It will be like a game level with 

a lot of 3D objects arranged inside the UDK 

engine. I was highly inspired by Conan Lore 

when I painted them. 

A lot of custom brushes were used too; some 

made by myself and others from the internet 

(Fig.06 – 08). 

In these two I was trying a new technique 

(Fig.09 – 10). 
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Sketchbook  Dimitar Tzvetanov



I learned it from the great Richard Anderson 

after watching his videos. I started the 

background of the image with a mix of 

paints. After playing with the layer modes 

you can get very nice results from which you 

can start to paint. 

Well hope you guys enjoyed this. Thanks!

Dimitar 
Tzvetanov
For more information please visit:

http://www.artbychrom.com/

Or contact them at:

chrom@artbychrom.com
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Artist: 

Andrew Jones
website: www.shareoneplanet.org
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Share One Planet

Commonweal and Art Hand-
In-Hand: “Share One Planet” 
Keep Drawing
The development of industrialized society 

brings unprecedented pressure to the nature 

environment, which cause the speeding 

decrease of wildlife habitats. Everyone 

should pay attention to what we are facing. 

Art and commonweal join hands enhancing 

awareness of global wildlife protection, the 

“Share One Planet CG Art Elites Invitational 

Competition” has opened for almost half a 

year till now. This first international major 

CG art competition featuring wildlife theme is 

organized by Wild Animals Cultural Project Fund 

under China Foundation for the Development 

of Social Culture, China Institute of Strategy 

and Management (CISM), The International 

Association of Computer Graphics Artists 

(IACGA) and China Association for Global 

Development under the United Nations; its 

executive organizers are leewiART International 

Computer Graphic(CG) Art Promoting 

Organization and Beijing Imperial Court 

Development Company Ltd.

According to our latest statistics, the “Share 

One Planet” Competition has invited 331 artists 

from more than 50 countries/regions to join as 

entrant. We’ve received 113 WIP entries and 23 

final entries. Driven by their sympathy to wildlife 

and best wishes to human society, artists depict 

unforgettable moments of the animals they 

feel attached to. They are not just showing the 

world how skillful and talented they are, but also 

express their care and love to the planet we live 

in. The competition draws extensive attention 

with the help of coverage on international press 

such as CGSociety, ImagineFX; and also the 

series interview runs on Chinese magazine 

CGW.

Entrants are asked to create entries portraying 

endangered species in China. 100 species are 

listed as potential theme and the competition 

has ten routine categories and one special 

category: Portrait (digital painting & digital 

sculpture), herd (digital painting & digital 

sculpture), Mother’s love (digital painting & 

digital sculpture), Prey and Predator (digital 

painting & digital sculpture), Harmony (digital 

painting & digital sculpture), plus the Special 

Category Swan Lake (digital painting). Artists 

may choose their preferred categories, choose 

to create the most thrilling moment of the Mother 

Nature in their eyes, and to capture diverse 

beauty of distinct species.

At the invitation of “Share One Planet” 

Organizing Committee, several renowned 

international CG artists created promotion 

posters for respective categories. They are 

Andrew Jones, Adrian Smith, Daniel Dociu, 

Cecil Kim, Yin Weiye (Franc), Zhang Wang, 

Mélanie Delon and Chris Ayers. They illustrate 

their understanding of the idea “Share One 

Planet” over the following pages.

We appreciate the support and attention from 

CG artists, art armatures and people from all 

walks of life in favor of commonweal events 

everywhere. We hope to see more artists join 

our competition, to share their concern with 

the world, about wildlife, about Earth and our 

environment. Let this not only be a contest 

about art creation, even more, it will be an 

event fighting for a better future for animals and 

mankind.

General Information 
of “Share One Planet” 
Competition
The ‘Share One Planet’ Wild Animals CG Art 

Elites Invitational Competition is organized 

by Wild Animals Cultural Project Fund under 

China Foundation for the Development of 

Social Culture, China Institute of Strategy 

and Management (CISM), The International 

Association of Computer Graphics Artists 

(IACGA) and China Association for Global 

Development under the United Nations; its 

executive organizers are leewiART International 

Computer Graphic(CG) Art Promoting 

Organization and Beijing Imperial Court 

Development Company Ltd. The competition 

invites CG masters worldwide to take part. 

Winners will be awarded with prize money as 

well as special designed golden, silver and 

copper trophies. The Organizers hope the 

platform of ‘Share One Planet’ can be built for 

encouraging artists to create meaningful and 

inspiring CG works to raise global attention of 

the plight of those wild animals that are a part of 

the one planet.

The highest prize in this competition is “10,000 

USD + gilded trophy”. Entry submission 

deadline is April 20th, 2011. It’s open for CG 

artists all over the world and everyone who 

want to contributes his/her share for wildlife 

protection.

Questions regarding participation please 

consult: shareoneplanet@gmail.com

Competition Schedule
Submission: August 1st, 2010 – April 20th, 2011 

23:59 (BJT, GMT+8)

Judging: May 1st, 2011 – June 1st, 2011

Awards Announcement: June 15th, 2011

For more information please visit: http://www.

shareoneplanet.org
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Andrew Jones
Andrew Jones has been heralded 

as “the apocalyptic art shaman” 

Beginning his career working 

with George Lucas at Industrial 

Light and Magic, he then went 

on to materalize a new vision for 

Nintendos’ Metroid Prime series. 

He’s now senior concept artist at 

Retro Studios. He also co-founded 

the famous concept design website www.conceptart.org. 

http://www.androidjones.com/

Adrian Smith
British illustrator, he got his name 

on the long list of fantasy scifi artists 

when took his first commissions for 

“Games Workshop”, especially famous 

for his concept art for “Warhammer” 

series. Now he’s busy providing 

service for Seoul Visual Works. Other 

clients includes EA games, Ubisoft, 

THQ Australia, THQ Canada etc. 

http://www.adriansmith.co.uk/     
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Daniel Dociu
Born and raised in the capital 

of Transylvania (Romania), he 

studied art and architecture from 

a young age and got his Masters 

Degree. After moved to the US in 

1990, he worked for Squaresoft 

and EA, as well as consulting for 

Microsoft and numerous other 

developers and publishers. For the 

past seven years he has been with Arenanet a fully owned subsidiary 

of NCSoft, as the Studio Art Director and Project Art Director for Guild 

Wars/ Guild Wars 2. He also functions in a Chief Art Director capacity 

for NCsoft West. 

http://www.tinfoilgames.com/

Franc
One of the few Chinese artists who 

first practice CG art, he is published 

many times in the renowned 

international CG annual series 

“EXPOSÉ” and “Exotique”. He now 

works as Art Director for international 

interactive game projects, clients 

including important enterprises like EA 

and 2K.

                                                         http://www.franc-art.com
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Zhang Wang
Chinese CG artist, graduated 

from the Oriental Culture and Art 

Department of Nankai University. 

He used to be professor at 

Animation Department of Tianjin 

University, then turned to teach at 

Nankai University. His works were 

featured in “EXPOSÉ 2” and won 

many awards both in China and 

international exhibits. He also provided character design for various 

projects of “Novoland”, as well as game titles such as “Shushan 

Online”, “Wan Mei” etc.

 

Cecil Kim
Born in 1972, Soul, Korea, then 

moved to US in 1990. He graduated 

from the Art Center College of Design 

in 1996 and worked at Square USA 

from 1997 – 2000. He now is Lead 

Concept Artist of Sony Computer 

Entertainment America Santa Monica 

Studio, mainly works on “God of War” 

titles. He is also instructor at Otis 

College of Art and Design Los Angeles and Gnomon School of Visual FX. 

http://www.cecilkim.com/





This month we feature:

Rafael Nascimento

Andreas Rocha

Amenov Vitaliy

Tiago da Silva

Paul Abrams

Sasha Gorec

JP Räsänen

Claire Beard

Steve Jung

Songnan Li 
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Black Queen
Paul Abrams

http://www.paulabrams.com 

obliviongrin@yahoo.com

Knight and the Lady
Steve Jung

http://www.jungsketch.blogspot.com/ 

stevejungart@gmail.com
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Face
Rafael Nascimento

http://rafaelnascimentoart.blogspot.com/ 

rafaelp.nascimento@hotmail.com

Climate Changes
Tiago da Silva

http://grafik.deviantart.com/

tmds77@gmail.com



Streets
Claire Beard

http://www.clairebeardart.com

claire.b.art@hotmail.com
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Chef
Sasha Gorec

http://sasha-gorec.livejournal.com/ 

sashagorec@gmail.com

Waking Light 
Andreas Rocha

http://www.andreasrocha.com 

rocha.andreas@gmail.com
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Elf 
Amenov Vitaliy

http://red-daddy.blogspot.com

amenvita@gmail.com

Convoy in Sandstorm
JP Räsänen

http://www.jprasanen.com 

juhis_r@hotmail.com



Shadow
Songnan Li 

http://blog.sina.com.cn/oldmole 

wuminggege0202@yahoo.com.cn
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All Tutorials Are Now Available 
As DVDs, Digital Downloads,

And Part of The Online Training Subscription

www.thegnomonworkshop.com

In this two volume series, Scott Patton shows the processes he uses to 
create a 3D character for feature films. The first volume explores 
Patton's fast and efficient method for concept sculpting, skipping the 
2D sketch phase all together and designing the character entirely 
within ZBrush®. He covers everything from blocking out the forms 
and fleshing out the muscles, to adding props, detailing with alphas 
and posing the character. The second volume covers methods for 
crcreating a final color rendering using ZBrush and Photoshop®. Patton 
shows how he squeezes the most from ZBrush’s powerful renderer to 
create both a wide and close-up shot of the character. He then shares 
creative Photoshop tips and tricks to quickly get to a finished piece of 
concept art from the ZBrush renders, covering topics such as adding 
and refining skin texture, hair, eyes, shadows and scars. Patton also 
discusses how to create backgrounds that enhance the character and 
ovoverall composition.

3D CHARACTER DESIGN SERIES
WITH SCOTT PATTON

LEVEL UP YOUR DIGITAL SCULPTING SKILLS

TRAIN WITH KILLER ARTISTS



Some 

things in 

art cannot 

be avoided, 

and some things 

must be understood to 

create great images. We 

call these Art Fundamentals. 

The same compositional rules 

and techniques to demonstrate depth 

of field are being used today as were being 

used hundreds of years ago. In this series industry 

professionals will be teaching us the art fundamentals that 

they put into practice, and will be sharing amazing tips that we can 

all use to improve the quality of our work.

Chapter 01 |  January Issue 061
Composition

Chapter 02 |  This Issue
Lighting and Color

Chapter 03 |  Next Issue
Portraying Emotion

Chapter 04 |  April Issue 064
Story Telling

Chapter 05 |  May Issue 065
Perspective and Depth



page 37www.2dartistmag.com Issue 062 February 2011

Art Fundamentals Chapter 02: Lighting & Color

Art Fundamentals Article: 
Chapter 02 - Lighting & Color 
Software used: Photoshop

Lighting and color are two massively complex 

and broad fields, and it is by no means possible 

to fully discuss the theoretical principles of either 

in this article. There are many great resources 

out there that deal with these subjects in 

great detail, from many different angles. Here 

however, I’ll provide some brief comments on 

some of the practical decisions concerning 

lighting and color while creating various 

concepts and illustrations. 

Pitch
This image (Fig.01) shows a scene where 

many different elements are competing for the 

viewer’s secondary attention. The ‘first look’ is 

meant to go directly to the football field, which 

is why it is shown in a very bright green, a 

color which in this image is reserved for the 

actual pitch only, and contrasts heavily with the 

predominantly bluish atmosphere. The ‘second 

look’ however, is more diffuse. There are over-

bright blue spotlights, lit advertisements, and 

the specks of saturated colors in the audience.  

The colors used for the crowds are of all hues, 

and to underline the large scale of the scene. 

These desaturate as the distance to the camera 

increases. Notice how at the far end of the 

stadium the distinction between the different 

colors in the audience has become almost 

negligible.

Cliff Dwellings
In terms of color the approach for ‘Cliff 

Dwellings’ (Fig.02) is simple: the scene is 

predominantly blue / greenish but to ensure it’s 

interpreted as a full color image a strong ‘offset

color’ is used: the orange lava. 

Because the orange is more or less the 

complementary color it immediately stands 

out. The lighting is diffuse as the sun is hidden 

behind the clouds therefore the scene is hit by 

indirect light only. 

Dzalou Freshwater Mangrove
In the swampy scene of Dzalou Freswater 

Mangrove, lights breaks through the dense 

canopy of the trees far above (Fig.03). 
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In this case patches of direct sunlight are used 

to guide the viewer around the image. They help 

to accentuate the important elements, such as 

the village in the tree roots, the fishing boats, 

and the woman carrying the basket. Because 

of the clear indication of where the sun is, there 

are also unlit areas that contain very little detail, 

which improves the composition. Color wise, 

the approach of the image is similar to Cliff 

Dwellings as the dominant color (greenish blue) 

is offset by some small patches of very different 

and saturated pockets of color here and there.

Arctic Research Outpost
Whenever I paint snow I continually guard the 

readability of four different values: snow in 

light, snow in shadow, rock in light, and rock 

in shadow. Whenever the distinction between 

these becomes fuzzy, the image will become 

harder to read. In reality however, the matter 

is often not as simple, as snow catching direct 

sunlight can be so bright it will push virtually 

every other value into the black. 

However, when you’re doing a painting, you can 

‘cheat’ yourself around this exposure problem 

by making sure the snow and rock reads and 

the distinction between the four values is 

maintained. Keep in mind, the separation of 

these four areas is relative to the distance to the 

camera. For example, in this picture, the snow in 

shadow in the foreground is darker than the rock 

in shadow in the distance (Fig.04). 

Indigo
With the shot of the top of the pillar as shown in 

Project Indigo:

(link: http://www.jessevandijk.net/g_08_76.html) 

the intent was to show not only the pillar 

itself, but also some of its context, some of it 

even outside of the frame. It mainly employs 

lighting and color to achieve this. Color wise for 

example, the isolation of this crowded city state 

is underlined by the difference in color between 

the city (vibrant, warm yellows and reds) and the 

bleak, cold grays of the outside world (Fig.05). 

Unspecified objects outside the composition 

cast shadows that help to make the sunlit areas 

seem even more inviting, as well as suggesting 

there is more going on in this world than merely 

that which is shown inside the frame.

Netherworld Archipelago
In the image of the capital of the Netherworld 

Archipelago lighting is key, and in this case it’s 

far more important than color (Fig.06). 
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The lighting clearly enters the cavern through 

some unseen hole in the ceiling, but individual 

colors are much harder to discern. The palette 

is mostly a warm greenish blue, except for 

the banners, which, in terms of color, are very 

deliberately different from everything else to 

make them stand out. 

Spiritual retreat
The aim for the mood of this image was very 

clearly defined: it had to be a very sunny setting, 

with lush vegetation, and birds singing (Fig.07).

A place you would want to relax: a veritable 

spiritual retreat. To prevent the entire image 

becoming overly green, many different colored 

plants and trees were added, such as the pink 

cherry blossom trees. For the ‘full color’ feel of 

the image, the patch of blue sky is important, as 

it is one of the few instances of bright blue. To 

emphasize the brightness of the direct sunlight, 

the lit areas contrast strongly with the shadowed 

ones.

Procession of the Dead
As this image was used as a book cover, the 

color scheme needed to be simple but striking 

(Fig.08). 



page 41www.2dartistmag.com Issue 062 February 2011

Art Fundamentals Chapter 02: Lighting & Color

When you zoom out you can see all major color 

essentially boils down to a linear gradient from 

warm browns in the lower left corner, to cold, 

deep blues in the top right corner. Book covers 

leave very little room for subtlety, as they need 

to stand out on shelves amongst many other 

titles. Brute force approaches such as the 

color scheme in this image are often employed 

because of this. 

The lighting is vague, predominantly to allow 

for lots of darks around the lit character - the 

contrast needs to be highest here in order to 

properly catch the viewers eye.

Uriel 9
Uriel 9 uses a similar approach to ‘Procession 

of the dead’ and ‘Netherworld Archipelago’ 

(Fig.09). 

The overall color is quite muted, but the bright 

orange bands on his armor provide lots of color 

contrast. The other implementations of color are 

more subtle: colder shadows, greenish haze 

near the ground plane, warm spotlights. The 

dominant light source is directed to emphasize 

the most important part of the robot, the upper 

torso and head. The images used for the Dutch 

“Duivel” trilogy by Adrian Stone are another 

example of the importance of forgetting about 

subtleties when doing book covers. 

The cover for part one needs to be immediately 

distinguishable from parts two and three, and 

vice versa. 

The lighting is not very clearly defined, and in 

that sense the scene isn’t very realistic. The 

main reason I wanted the background behind 

the characters to be so bright, was to ensure 

that their silhouettes stood out as much as 

possible in the scene (Fig.10). 

About Jesse
Jesse van Dijk (1977) is a concept artist from 

Amsterdam, the Netherlands. His primary 

focus is world design for games and other 

entertainment media. Jesse currently works at 

Guerrilla Games / SCEE as a senior concept 

artist. He graduated at the Delft University of 

Technology with a Master’s degree in Industrial 

Design Engineering in 2003. After his studies he 

worked for several game development studios 

prior to joining Guerrilla in 2009.

Jesse van Dijk
For more information please visit:

http://www.jessevandijk.net

Or contact them at:

jesse@jessevandijk.net
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 tool and it's brilliant!”
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Intro Text

“I find it far easier to 
see where something 

may be wrong if all of 
the components are in 

place. If you were to 
paint a perfect mouth 

and nose they may 
still look wrong 
if the eyes were 

missing.”

Chapter 04 | Male  | Richard Tilbury

Portraits are one of the most commonly tackled subjects in all forms of art, but also one of the most common that we see 
go horribly wrong. In this series our talented artists will be showing us how to use a photo reference to paint an accurate 
portrait without being tempted to do a paintover. We don’t stop there though; we also venture into the specialized field 

of caricatures. Caricatures are a tricky subject to deal with, but there are ways that you can use your photo reference to 
make them easier and this series gives us an insight into this process.
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Portraiture - Chapter 04: 
Male  
Software used: Photoshop

Introduction
This tutorial required a portrait to be painted 

using a photo as a reference and so the first 

decision that needed to be made concerned 

the subject. I decided to paint my son Gabriel 

and so picked up the camera and tried my 

best to persuade him to sit still while I took a 

few pictures. I photographed him from different 

angles in order to get a variation in the lighting 

and in the end opted to use the photo seen here 

in Fig.01.

I also photographed him from the opposite side, 

but most of his face was in direct light and so did 

not look quite as good as this angle where there 

was a more interesting play of light and shadow.

I liked this particular photo compared to the 

others partly because of the light, but mainly 

because of his expression which looked 

strangely melancholic; probably caused in no 

small part by my asking him to sit still for what 

seemed like an endless period of time! Anyway 

after taking a series of photos and some 

consideration I went for this one and could get 

on with the painting.

Blocking In
When it comes to digital painting the canvas 

proportions are not crucial as you can always 

extend the frame later or alternatively trim 

it, which is a luxury unavailable to traditional 

painting without re-stretching. I opted for a 

traditional portrait ratio and then began to make 

a mess on the background to get rid of the white 

void. I always keep the character separate from 

the background so that I can experiment with 

the color schemes independently. I used an 

array of brushes when blocking in, which ranged 

from the standard Hard Round brushes to Chalk 

ones that incorporated a Dual brush.

Fig.02 shows two details which use different 

brushes alongside a color palette in the top 

left corner. I created this palette so that I could 

quickly pick the light, mid and darker tones 

whilst roughing in the general tones. You could, 

in fact, use the photo directly to establish your 

palette, but it will not be good practice for your 

eye and so I prefer to do it the old fashioned 

way; after all we do not want an identical copy.

Whilst working on the initial stages I like to 

reduce the size of the canvas so that I get a 

good overall impression of the painting and am 

not carried away with detailing. Fig.03 shows 
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In the middle stage you can see that I have 

provisionally added in a value for the white 

area of the eyes. I have also blocked in the 

highlight catching the lower eyelid together 

with the shadow around the eye socket. This 

intermediate stage is used to sketch in the eyes, 

nose and lips so that I have a clearer idea about 

the overall proportions and their relationships.

If any part of a portrait is wrong it will have an 

impact on the whole face and how we perceive 

it and so it is important to balance everything 

carefully. You can see in the final stage that all 

the features are now in place and how much 

more successful the image reads as a result. I 

find it far easier to see where something may 

be wrong if all of the components are in place. If 

you were to paint a perfect mouth and nose they 

may still look wrong if the eyes were missing. 

These are what I think of as the foundations and 

from here I usually begin the process of building 

and refining the painting.

Adjusting and Refining the 
Features
The background looked a little too messy and so 

I made this look more uniform first of all. I then 

copied the eyes onto a new layer and used the 

Transform tool to re-position them and change 

the scale.Fig.05 shows the modified version on 

the right with some guidelines to better show the 

changes. The angle of the eyes has changed as 

well as the relationship between the left eye and 

the nose. 

the typical view of my workspace with both the 

photo and the canvas at about the size I use to 

begin with.

Fig.04 shows the progress from the initial block 

in through to putting in the features. I find it is 

always good practice to work on the image as 

a whole and develop each area of the canvas 

at a similar pace. This way it is easier to see 

which areas may be wrong or need alteration. I 

could see at this point that the proportions were 

inaccurate, but I find it is much better to have 

something on the canvas. After all it is easier to 

change something when it is in front of you as 

opposed to existing purely in your head. During 

this phase I used the color palette to block in 

the volumes and get a sense of the light in the 

photograph.

I find the best way of tackling any painting that is 

based on “real world” observation is to establish 

early on the key areas of dark and light. In this 

case there is a distinct shape created through 

the face and hair that marks the boundary 

between the highlights and shadows (see red 

lines).

I often squint my eyes and try and get a 

simplified view of what I am looking at, as 

this encourages a keener focus on the main 

structure and proportion of the subject as 

opposed to any details.
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this and the highlights required some finer detail. 

Fig.07 shows the image beforehand (left) and 

the result of this additional layer.

The thing to remember about portraits is that 

the smallest of changes can have a seemingly 

big impact on both the likeness and expression. 

I noticed that the right eye looked too small 

compared to the near one (left image in Fig.06) 

and so I used the Edit > Transform > Scale tool 

to address this. I also saw that the mouth shape 

was wrong, with too much shadow between the 

lips and no curvature to the upper lip.

There are two main ways I change things in 

a painting and one is by copying and pasting 

selections and then using Transform tools, such 

as Scale and Rotate, before blending these 

back in using the Eraser and some brushwork. 

The other method is by way of the Warp tool, 

which is equally useful but I advise doing this on 

a duplicate layer because if you are not careful 

you can end up with some obvious distortion.

So far I have been adjusting just the features of 

the face as these are the more crucial elements 

but the hair and shoulders needed to catch up a 

little. I created a new layer temporarily and then, 

using a finer brush, painted in some strokes 

to add some definition. Most of the hair is in 

shadow when looking at the photo and so can 

be broadly blocked in, but the transition between 
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This is generally the pattern I followed from 

here on in; creating new layers for additional 

refinements and detail, and then flattening 

everything once I was happy. Fig.08 shows one 

such version with a smoother transition between 

the light and dark tones.

You will also notice that I have altered the 

background, which remains as a separate layer. 

I kept a darker area to the right-hand side and a 

lighter band behind the head in order to create a 

contrast and play of light against dark. To reflect 

the warmer tones of the face and hair I also 

added in some reddish tones to help balance 

the portrait with the background.

Final Stages
In some ways I could have stopped the painting 

here, but there were still a few improvements 

that could be made. Fig.09 shows a more 

refined version of the t-shirt, although this could 

have been left, which often lends a fresher 

quality to a painting as well as giving the viewer 

a better glimpse into the processes. Perhaps 

more significant is the change to the angle of the 

chin, which is now sharper, and the shape of the 

right pupil and lens, which has a more elliptical 

shape. The nose has also been modified slightly 

with a more defined change of angle as it slopes 

up towards the forehead. All of these changes 

are indeed modest, but collectively create an 

important difference to the overall portrait.

You will hear many artists say how valuable it is 

to flip their canvas horizontally from time to time 

in order to reveal any problems that they feel are 

there but cannot detect. I am no different in this 

respect and do this frequently throughout the 

process. In Fig.10 you can see in the right-hand 

version that I have scaled up the left eye slightly, 

which looked wrong once I flipped the canvas.

One thing to be aware of is that a camera is 

liable to distort a person due to the lens and 

so when painting from this type of reference 

you may need to adjust proportions in order 

to account for this. I think in the end that you 

may need to balance what you see with what 

you know and use a little artistic license if you 

feel the painting does not look right.

Another aspect which was not wholly accurate 

was the width of the hair and neck, which looked 

too big. Using the Warp tool I pulled in the left 

edge, which made the neck look more slender 

and the area of hair somewhat smaller. Fig.11 

shows the portrait beforehand (left) alongside 

the result of this subtle transformation.

This almost concluded the portrait barring a soft 

highlight below the nose and a slight tilt of the 

lips. Here is the final version which I hope has 

done my son justice (Fig.12).

Richard Tilbury 
For more from this artist visit:

http://www.richardtilburyart.com 

Or contact them at:

rich@3dtotal.com
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Fantasy plays a huge part in digital art. It influences thousands of 

artists from around the world and has become a large part of the film 

and gaming industry. So much of what we see within this genre is 

drawn from fairy tales and folklore. In this tutorial series our artists will 

be showing us how to research creatures from folklore and use this 

gathered information to create an original and accurate depiction of 

these fantasy characters.

Chapter 1: September Issue 57 | Goblin | Andrei Pervukhin 
Chapter 2: October Issue 58 | Fairy | Nykolai Aleksander 
Chapter 3: November Issue 59 | Siren | Min Yum 
Chapter 4: December Issue 60 | Ogre | Richard Tilbury 
Chapter 5: January Issue 61 | Troll | Simon Dominic 
Chapter 6: This Issue | Huli Jing | Jason Wei Che Juan
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Painting Creatures From 
Folklore: Chapter 06 - Huli 
Jing
Software used: Photoshop CS3

With nearly 4,000 years of history, the Chinese 

culture has a lot of its own folklore, which 

includes songs and tales that tell stories of 

history, human nature, or love. With this image 

I wanted to explore the story of Daji and King 

Zhou of Shang in 1047 BC. Daji was a favorite 

concubine of King Zhou of Shang. She is a 

classic example of how beauty can cause the 

downfall of an empire or dynasty in Chinese 

culture. She is portrayed as an evil fox spirit 

in the Chinese novel Fengshen Yanyi, which 

is translated as “The Investiture of the Gods” 

or “The Creation of the Gods”, also known as 

Fengshen Bang. 

I am always building my own small library of 

books and keep them by my side. Wikipedia or 

online search engines like Google or Bing are 

very good resources, but be aware that there 

are still tons of resources out there that you 

cannot find online.

Strong initial sketches make the whole 

processes much easier, so establishing a good 

sketch from the beginning is way more efficient 

than fixing problems later. Some people think 

one of the biggest benefits of digital paintings 

is the Undo button, but I feel that is not true. If 

you do it right from the beginning, why do you 

want to do it wrong, undo it, and do it again and 

again? It is the same as traditional painting. 

It is always good to start heading in the right 

direction, so you can just keep developing the 

image until is completed.

The first stage is to define the characters. In 

this case it is based on existing characters so 

research is very important, but don’t let the 

story restrict the illustration and imagination. It 

is always good to add a little personal flavor to 

it. In this illustration I could have illustrated an 

event, but I wanted to focus on the characters 

themselves, so the key to the whole process is 

character design (Fig.01 – 02).

In the story, King Zhou (in his later years) drinks, 

has sex, lacks morals, and ignores all the affairs 

of the people. After thinking about these words, 

some faces started to appear in my mind, so I 

focused on the faces and tried to capture the 

expression on them and play with values for the 

composition.

Strong contrast and value are two major things 

I use to design everything. I also found some 

Western Zhou Dynasty 1046–771 BC pictures 
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and one is value. Again the quick way to design 

it is using rough brush strokes with value 

and flow. I also introduced fox spirits into the 

painting at this point (Fig.04). At this point I tried 

to define the elements in the background and 

for design references. Human anatomy is 

always a big topic when people talk about art, 

and that is why people spend years and years 

learning it. There is no shortcut; the only way is 

to study it and do more life drawing sessions. 

Skin rendering is another big topic, and Fig.03 

shows a crop image of the skin in different 

stages. The trick is simple: more color. I rarely 

put in one solid color in a painting. Skin has 

more color than any other surface or material 

because it is so complex. One thing I do find is 

that usually the dark value has higher saturation. 

Another thing is that changing the hue and 

saturation will also change the value. I usually 

try to keep the value the same, which should 

mean as long as we keep the value the same, 

potentially we can fill in almost any color.

When it comes to backgrounds there are two 

things that define 3D space. One is perspective, 

foreground, and separated those into different 

layers which can help my process later.

Next it was all about the water. I looked at 

some photos of the ocean, which I took in the 
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Olympic National Park in Washington State. I 

spent about eight hours painting water. I find 

painting water is very similar to drapes and 

fabric because the surface is smooth (Fig.05). I 

also think that the perspective of the waves was 

important for this scene; once I nailed down the 

waves the water looked good. The further away 

the waves are the smaller and flatter they look.

A quick lighting test on the characters gave me 

an idea of what the moon light looked like. The 

collapsed building was a good way to show the 

empire falling and represent war. Color started 

to kick in to the painting, and since this was not 

a happy story or a happy ending for them, a cool 

color tone suited the painting. I used a Soft Light 

layer in Photoshop for the initial color.

This stage is all about rendering and adding 

more details to the smaller areas to fill the 

empty space (Fig.06). This is extremely time-

consuming and the more you understand 

lighting and the forms of objects the better you 

can do it. Painting still life and human figures 

will improve your rendering skills. At this point 

I decided the background and the moon were 

over-emphasized and I decided to take the 

moon out (Fig.07). Also at this point I started 

to tackle the contrast and value of the water. 

Adding a couple more interesting structures 

in the far background also helped the painting 

have more depth. Using the Overlay and Soft 

Light layer again and again is like glazing in 

traditional media. The more layers you apply to 

the painting, the richer color it will look. Again, 

as long as we keep the value the same, we can 

put in almost any color we want.

When painting a complex scene with more 

than one character in it, the foreground and 

background can be very difficult. The difficulty 

is not the single subject or single character. It is 

the balance of everything. It is like a balancing 

game; when we do too much on one side, we 

need to decide to take it out or add more to the 

other side. I changed the skin tones so that 

Daji would be the first to be seen, and I also 

changed each individual element slightly to lead 

the viewer’s eye a bit more (Fig.08). 

Detail is another thing that needs to be 

addressed. When painting on a computer we 

zoom in and out often and sometimes this will 

make us lose the sense of detail, and over-detail 



certain areas. You can balance this out with 

careful use of the Smudge tool.

Even in a complex scene made up of small 

objects, the keys are design, composition, 

balance, value, and perspective. Each part 

should be addressed, and to master it you must 

study and practice it. I hope you enjoyed this 

tutorial (Fig.09).

 
Jason Wei Che Juan

For more information please visit:

http://jasonjuan.blogspot.com 

 http://www.jasonjuan.com

Or contact them at:

jasonjuan05@gmail.com
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The fantasy genre is hugely popular in the CG industry and has been showcased in hundreds of 

movies, computer games and artworks over the years. With such potential for magic, monsters 

and imaginations to run wild, it’s easy to see why fantasy is such an attractive subject. But giving 

fantastical ideas enough of a basis in reality to be convincing can be difficult. In this series our 

talented artists are going to take one aspect of fantasy – legendary creatures – and show us 

how they would tackle this problem. Some use photo integration, others paint the creatures very 

carefully with a steady hand, but all share the benefits of their experience and reveal the tricks and 

techniques they use to make the unreal seem real.

Chapter 1 |  January Issue 061
Griffin

Chapter 2 |  This Issue
Giant

Chapter 3 |  March Issue 063
Dragon 

Chapter 4 |  April Issue 064
Yeti

Chapter 5 |  May Issue 065
Loch Ness Monster

Chapter 6 |  June Issue 066
Alien
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Photoreal Fantasy - Giant 
Software used: Photoshop

Introduction
The aim of this tutorial was to produce an 

image that looked like a convincing photograph 

of a creature that does not exist in reality, but 

perhaps could have resided somewhere in the 

world. I imagined a scenario in which a rare 

snapshot has captured a unique glimpse of 

a mythological creature. Before starting this 

painting I recalled photos I had seen as a child 

relating to Bigfoot and the Loch Ness Monster 

and their alleged existence. The pictures lacked 

any real clarity, suggesting they were perhaps 

hoax photographs. I had already chosen a 

giant as my topic, but needed to decide on the 

context and environment. I initially thought about 

a mountainous habitat and then considered the 

jungle as this would be a great place to remain 

elusive and hidden from civilisation.

Thumbnail Sketches
With a jungle theme in mind I started 

making some small sketches to work out the 

composition. I considered a river with a large 

silhouetted figure strolling across the valley 

floor, with perhaps some characters in the 

foreground. Fig.01 shows a few variations 

on this theme with the viewer looking down 

river and catching sight of a wandering giant. I 

experimented with some sand banks where the 

characters could be positioned, but somehow 

the jungle environment did not feel right. 

I then considered a misty forest in the foothills 

of a mountain range where visibility would be 

restricted and hence make for an ambiguous 

photo, although this seemed a little clichéd. I 

began thinking of more unusual environments 

and the one which seemed less obvious was a 

desert. This isn’t the greatest place to hide but 

they can be vast and inhospitable, therefore 

providing a remote environment for a giant 

to exist away from mankind. I imagined the 

creature venturing out from his canyon habitat 

in search of food or water and happening to 

be caught on camera by an unsuspecting 

photographer attached to a small party of men.

Blocking In
Fig.02 shows my initial block-in, with the giant 

striding past a rock formation. I planned on 

eventually situating the men in the foreground 

sheltered behind the rock, with the photographer 

being in the extreme foreground behind the 

camera. During this stage I built up the image in 

three distinct layers: the foreground, including 
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the rock and sand, the sky and finally the giant. 

Keeping these three sections separate meant 

that each aspect could be modified easily 

throughout the painting process. Because this 

task involved creating an image that might be 

interpreted as a photo it required some actual 

photographic elements borrowed from a matte 

painting approach.

Using Photographs 
Fig.03 shows a sample of photos I 

took from 3DTotal’s free library: http://

freetextures.3dtotal.com/ . The two rock 

images can be found under Nature > Rock, with 

the sky being located under Nature > Skies. The 

two rock images were color corrected to match 

and then scaled and rotated to fit the painting. 

The sky was also desaturated slightly and 

pasted in behind the giant and foreground.

I found the image of a distant rock outcrop, 

which I used to add some background 

scenery (Fig.04): http://freetextures.3dtotal.

com/preview.php?imi=8326&s=c:Rural_

Environments&p=0&cid=17

Using further sections of rock I built up the 

foreground and then pasted in two palm trees 

from the reference library (Fig.05). The sand 

in the immediate foreground was built up from 

three photos, with the two principal ones visible 

in Fig.06.

When using photographs it is important to 

color adjust them so that they match closely. 

My first port of call was Image > Adjustments 

> Brightness/Contrast, followed by Image > 

Adjustments > Color Balance. Once the photo 

elements were in position they were blended 

together using a combination of the Clone 

Stamp and Eraser tools. 

Up until this point I’d only really worked on the 

foreground area and so it was time to address 

the giant and add some definition. I found an 

image of a man wearing some ragged-looking 
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clothes in the medieval section of the library and 

thought this would make an apt reference. 

Fig.07 shows the original photo and its new 

location in the painting. Because the giant is 

meant to be some distance from the camera 

I reduced the contrast by way of Image > 

Adjustments > Curves and then added some 

highlights across the shoulder to blend him in 

with the scene lighting.

The scale of the rocky outcrop looked too small 

compared to the palm trees and so I decided to 

move this section into the middle distance and 

re-do the foreground. Fig.08 shows the new 

outcrop and the three photos that have been 

used from the reference library to start building 

the detail into the giant. You can see that I have 

made up the arm from two photos, the forearm 

from one and the hand from another (right 

inset). The upper arm was extracted from a third 

one, which you can also see in the lower part. 

All three images were taken from the Medieval 

> Civilian section of the library. Whilst browsing 

through the reference library I came across a 

German military vehicle and instantly decided 

to use the theme of warfare and maybe even 

suggest some bizarre military experiment.

I wanted to set this picture somewhere in the 

past, as mentioned in the introduction, and 

having recalled a TV series about World War 2 

that was retouched in color, I thought this would 

be ideal. I imagined this to be a retouched photo 

from that period, which allowed me to make 

it look old and therefore suggest a sense of 

doubt about its authenticity. I promptly pasted in the vehicle in question and then added in two 

soldiers in the foreground 

The face was roughed in, but given the 

scale and distance of the character it only 

really needed to read tonally as opposed 

to incorporating any real detail. Here is the 

detail of the giant’s head, which you can see 

is vague and lacking any real clarity (Fig.09). 

This was done in part to raise a question about 

the authenticity of the eventual image, but 

also because he is set in the distance and is 

obscured by atmospheric perspective.

 

Bringing Everything Together
At this point all of the crucial components were 

in the image and it was time to gel everything 

together and add the final touches. The first 

thing I needed to do was add some motion blur 

to the giant as he would be taking large strides 

across the landscape. To do this I duplicated 

the layer and went to Filter > Blur > Motion Blur. 
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I then reduced the opacity to around 50% and 

rotated it slightly (Fig.10).

I didn’t want to blur him completely, but rather 

focus on the areas that were moving the most, 

such as the arm and head.

I repositioned the soldiers and vehicle and then 

added a Curves > Adjustment Layer to add 

some highlights to the palm trees (Fig.11). This 

is done by going to Layer > New Adjustment 

Layer > Curves. After this I adjusted the curves 

to make the trees lighter. I then used black to 

paint into the mask (see highlighted thumbnail) 

to restrict the highlights to just the left sides. You 

will also notice that I added some dust to the 

vehicle and soldiers courtesy of a new layer of 

color set to Overlay.

I added two new adjustment layers – Curves 

and Levels – in order to add a brighter light 

into the image. Once applied, I painted into the 

masks to control the effect as well as painting in 

some sun glare (Fig.12). Image Adjustments and 
Filters
At this stage I flattened the layers and then 

applied a Film Grain filter (Filter > Artistic > Film 

Grain), as seen in Fig.13. I then used some dirt 

maps to add an edge around the image akin to 

old photographs. I inverted the map, moved and 

scaled it accordingly and then set the opacity to 

around 40% (Fig.14).

To add some scratches and imperfections I 

sampled other dirt maps and set the blending 

mode to Color Dodge at 80% opacity (Fig.15).

To add some color tinting that will help give it 

that retouched quality, I applied another dirt 

map, which I partially erased and then set to 

Soft Light at 60% opacity (Fig.16_1). I then 

applied a Photo Filter, which can be found under 

Image Adjustments; in this case a Warming 

Filter. This essentially balances the light and 

adds a warm yellow tint, which helped to age the 

image (Fig.16_2).
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The third adjustment I made was courtesy of 

Image > Adjustments > Exposure. I used this to 

add a further contrast, which is often a quality 

seen in older photographs where there is a 

slight overexposure (Fig.16_3).

Perhaps the last key aspect to add for a little 

more authenticity was a vignette – a feature of 

early photography caused by lens limitations or 

deliberate camera settings. To do this I created 

a new layer and filled it with white. You then 

need to go to Filter > Distort > Lens Correction 

and reduce the Vignette amount (Fig.17). Once 

done, this layer can be set to Multiply blending 

mode and voila!

With this last adjustment the image is complete 

– a color retouched photo from another era 

capturing a rare glimpse of a giant as he strides 

through the deep desert. 

Richard Tilbury
For more information please visit:

http://www.richardtilburyart.com

Or contact them at:

rich@3dtotal.com
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Yuehui Tang is a fantastic artist and has a great way of painting portraits. In this Making Of he 

shows us how he painted his image “Portrait” by starting with a black page, adding the light and soft 

tones to create a grayscale image, and then painting over it.

“It is important to get 
the correct levels of 
dark in the shadow 
and show how the 

skin reflects the 
light.”
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Making of Portrait 
Software used: Photoshop 

When I began this illustration I didn’t really think 

about what to draw. I simply started by building 

up the light in what seemed to be a sensible 

order. I did, however, need to concentrate at this 

point as it was my aim to establish the forehead, 

cheekbones, jaw and anywhere else that might 

catch the light (Fig.01).

I continued to add to the areas that reflected 

light and defined the image according to my 

understanding of women’s faces. I find that it is 

easier to keep things clean without the specific 

features being involved (Fig.02).

This is the first point where I started to detail any 

of the facial features. I usually deal with these 

whilst the image still has a hazy effect (Fig.03).

 

I then reduced the size of the brush to help 

me start doing the detail. It is important to pay 

attention to the expression of the eyes and 

mouth. I was trying to make the face look calm 

(Fig.04). 

In Fig.05 you can see that I was now happy with 

the look of the face and started to move onto the 

rest of the detail. You can notice that I opened 

the mouth as I thought that it went better with 

the slightly hazy eyes. I also added some 

highlights to the eyes. To make the subject 

of your image seem soft and mellow, a good 

technique is to limit the impact of the bones - in 

particularly the cheek bones.

I then started to add more layers to start working 

on the hair and other features in the image. 

From this point I was able to revisit all of the 

layers and develop the most suitable feelings to 

portray on the face. When I was totally satisfied 

I merged the layers so I only had one layer for 

the face, one for the hair and one for everything 

else in the scene (Fig.06).
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One I had finished and was satisfied with the 

base layers it was time to move on to the color. 

Firstly I added a layer over the image and then 

added further colors to select areas (Fig.07). If 

you were then to turn the layer mode to Color 

you would get something along these lines. The 

Color layer can get a little messy, which is an 

obvious drawback so I would suggest changing 

the blending mode to Overlay and adjusting it 

until you are happy. 

The next step was to detail the rest of the 

image, starting with the hair. From this point 

onwards I made a lot of small adjustments, 

starting with the face. It is important to get the 

correct levels of dark in the shadow and show 

how the skin reflects the light. I made sure that 

the levels of light and dark made the skin look 

slightly transparent. I then continued to give the 

image depth by intensifying the shadowed areas 

and distinguishing between the different areas 

such as the face and hair, and the hair and the 

background.  

As you can see, it was a case of building on the 

image layer by layer and at this point I found it 

necessary to concentrate on the highlights as 

this helped to enforce the feeling of volume, 

particularly in the hair. I had to remember that 

the highlights and the shadow needed to be 

considered together, as the lighter the highlights 

are the darker the shadow seems. It is always 

important to remember the contrast (Fig.08).

I continued to paint the hair carefully and then 

started to focus on the eyes and lips. It was 

important to show that these are reflective 

by using strong, carefully-placed highlights.  

At the same time I thought it was important 

to strengthen the shadows around the face 

(Fig.09).

I constantly added to the face, mainly adding to 

the light and shadow. It is important to look at 

the full image at this point to get a better idea of 

how the image is developing, so the image as a 

whole can be adjusted. The next step was also 

to start to add some feathers. The technique I 

used was to draw one feather and then copy it 

and adjust it in the different locations. I did this 

over about four layers, which also contained the 

light and shadow (Fig.10).

I thought that the hair still needed further work 

so I increased the hardness of the brush and 

decreased its size (Fig.11a). I also changed the 
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brush Jitter and Flow control to “Pressure”. It was very important to make 

sure that the hair didn’t look flat by varying its thickness and transparency. 

You can see the brushes I used in Fig.11b.

I then continue to paint the arms and neck. I also identified the parts of the 

hair that needed work and strengthened them by adding to the effect of 

light and shadow (Fig.12). 

The hair was continuously developed and at this point I made new layers 

to make adjustments as I didn’t want to adjust what I had. I also added 

eyelashes here (Fig.13 - 14).

In this final step I adjusted the colors. You will also notice that birds were 

added. I also went back into a few layers to tweak things a little (Fig.15). 



Yuehui Tang
For more information please visit:

http://www.cgtnt.com 

Or contact them at:

tyhart@163.com



View the entire 
Digital Painting Techniques: Volume 2 book  

online at: www.3dtotal.com/books

Digital Painting Techniques: Volume 2 provides another thrilling opportunity to learn from 
some of the most accomplished and skilled digital artists from around the world. 

The second volume in this series covers a wide variety of themes and topics and provides 
in-depth tutorials to aid and inspire any digital artist, whether beginner or veteran. Custom 
Brushes, Speed Painting, Characters and Fantasy are just a few of the subjects covered in 
the chapters of this must-have book, with each tutorial providing a logical and professional 
approach to creating a digital painting of the highest standard. 

With additional features including a gallery of stunning artwork and links to free 
downloadable content such as custom brushes, Digital Painting Techniques: Volume 2 
contains a wealth of inspiration and advice, making it a worthy addition to any artist’s 
bookshelf.

Softback - 21.6 x 27.9 cm l 288 Premium full color pages l ISBN: 978-0-9551530-1-3

Visit 3DTotal.com to see our full range Book products
3DTOTAL.COM

I have never seen one
book that has such a diverse 

collection of inspiring 
techniques and subject 

matter, generously shared by 
incredibly talented artists.
Dylan Cole | www.dylancolestudio.com



With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some 

exclusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-color, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Cowboy 
vs Sandworms” 

by Kekai Kotaki



The following shots of the “Cowboy Vs Sandworms” book pages are featured here in full-resolution and can be read by zooming in...



The following shots of the “Cowboy Vs Sandworms” book pages are featured here in full-resolution and can be read by zooming in...



View the entire 
Digital Art Masters: Volume 5 book online at

www.3dtotal.com/digitalartmasters_v5

Digital Art Masters is in its  
fifth edition now, and can easily 
be considered one of the best 
showcases of digital artwork 

available today. The quality of the 
artworks, the fine printing and the 
valuable walkthroughs make this 

book a must-have for any art lover 
and for any CG artist, professional 

or beginner.
Alessandro Baldasseroni | www.eklettica.com

Following on from the success of our first four books, we received yet another 
overwhelming response to our call for submissions for Digital Art Masters: Volume 5. Once 
again over 1,100 submissions made their way into the Digital Art Masters mailbox, proving 
to us that the series is becoming ever more popular with not only our readers, but artists 
around the world too!

From this massive number of incredible entries, the 3DTotal team began the difficult task of 
choosing approximately 300 images to take through to the next round. To help in the task, 
we enlisted the help of industry professionals Tim Warnock (matte painter), Till Nowak (3D 
artist) and John Kearney and Chung Wong (videogame artists - VooFoo Studios) to be our 
guest judges. These wonderful artists braved the headaches of a grueling judging process 
and helped the 3DTotal team to select the 50 stunning images that appear in this year’s 
fantastic line-up.

Hardback - 21.6cm x 27.9cm | 304 Full Colour Premium Paper Pages | ISBN: 978-0-240-52171-8

Visit 3DTotal.com to see our full range Book products
3DTOTAL.COM



Available from www.3dtotal.com/shop

Meet some of the finest digital 2D and 3D artists working 
in the industry today – Loïc e338 Zimmermann, Craig 
Sellars, Jelmer Boskma, Maciej Kuciara, Daarken, 
Marek Denko, Kekai Kotaki, Andrew Hickinbottom 
and Marek Okoń. Become inspired by breathtaking 
images, paired with the techniques and tricks of leading 
industry artists

• More than just a gallery book, learn from the best 
digital artists in the world; each artist offers insight 
into how their image was created, with discussions of 
techniques and problem solving solutions

• A source of inspiration for artists of all levels: cutting 
edge imagery showcases the best in today’s digital art

• Featuring more than 50 artists and showcasing over 
900 stunning color images in five sections: Sci-Fi, 
Scene, Fantasy, Character and Cartoon

“Digital Art Masters is getting better and 
better at showcasing some of today’s 
best digital artists. The way the book 
shows the processes of achieving great 
pictures provides a good opportunity to 
learn from these artists, and keeps you 
challenged in your own art.” 

Raphael Lacoste | www.raphael-lacoste.com/

volume 1 volume 2 volume 3
The first book in the 
Digital Art Masters 
series features 48 of 
the finest 2D and 3D 

artists, including Eric 

Wilkerson, Fred Bastide, 

Marcel Baumann, Meny 

Hilsenrad, Natascha 

Roeoesli, Robert Chang 

& Thierry Canon

The second book in the 
Digital Art Masters 
series features 58 of 
the finest 2D and 3D 

artists, including Benita 

Winckler, Glen Angus, 

James Busby, Jonathan 

Simard, Jonny Duddle, 

Philip Straub  & Tae 

Young Choi

The third book in the 
Digital Art Masters 
series features 60 of 
the finest 2D and 3D 

artists, including Damien 

Canderlé, James Paick, 

John Wu, Laurent 

Pierlot, Marc Brunet, 

Mathieu Aerni, Matt 

Dixon & Neil Blevins



page 76www.2dartistmag.com Issue 062 February 2011

About us  3DTotal

Is a resource website for the CG community; 

amongst our growing number of products for CG 

artists, we produce two monthly downloadable 

PDF magazines – 2DArtist and 3DCreative. 

We are based in the West Midlands, in the UK, 

and our intention with our magazines is to make 

each issue as full of great articles, images, 

interviews and tutorials as possible. If you 

would like more information on 3DTotal or our 

magazines, or if you have a question for one our 

team, please use the links below.

Contact Information
http://www.3dtotal.com

http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Simon Morse 

simon@3dtotal.com 

Lead Designer > Chris Perrins 

chrisp@3dtotal.com 

Marketing > Jo Hargreaves 

jo@3dtotal.com

Partners
If you have a CG community website and would 

like to support 3DCreative and/or 2DArtist 

magazine by showing our banners, please 

contact Simon at the email address above


